


Microsoft
®

Expression
®

Design on Demand

Copyright © 2008 by Pearson Education, Inc.

All rights reserved. No part of this book shall be reproduced, stored in a
retrieval system, or transmitted by any means, electronic, mechanical, photo-
copying, recording, or otherwise, without written permission from the publish-
er. No patent liability is assumed with respect to the use of the information
contained herein. Although every precaution has been taken in the prepara-
tion of this book, the publisher and author assume no responsibility for errors
or omissions. Nor is any liability assumed for damages resulting from the use
of the information contained herein.

Library of Congress Cataloging-in-Publication Data
LoCascio, Ted.

Microsoft Expression Design on demand / Ted LoCascio.
p. cm.

Includes index.
ISBN 0-7897-3826-0

1.  Computer graphics. 2.  Microsoft Expression Design.  I. Title. 
T385.L618 2008
006.6’86—dc22

2008006818
ISBN-13: 978-0-7897-3826-4
ISBN-10: 0-7897-3826-0

Printed and bound in the United States of America
First Printing: April 2008

11  10  09  08             4  3  2  1  

Que Publishing offers excellent discounts on this book when ordered 
in quantity for bulk purchases or special sales. 

For information, please contact: U.S. Corporate and Government Sales

1-800-382-3419 or corpsales@pearsontechgroup.com

For sales outside the U.S., please contact: International Sales

1-317-428-3341 or International@pearsontechgroup.com

Trademarks
All terms mentioned in this book that are known to be trademarks or service
marks have been appropriately capitalized. Que cannot attest to the accuracy
of this information. Use of a term in this book should not be regarded as
affecting the validity of any trademark or service mark. 

Microsoft and the Microsoft Office logo are registered trademarks of 
Microsoft Corporation in the United States and/or other countries.

Warning and Disclaimer
Every effort has been made to make this book as complete and as accurate as
possible, but no warranty or fitness is implied. The information provided is on
an “as is” basis. The authors and the publishers shall have neither liability nor
responsibility to any person or entity with respect to any loss or damage aris-
ing from the information contained in this book.

Publisher
Paul Boger

Associate Publisher
Greg Wiegand

Acquisitions Editor
Loretta Yates

Development Editor
Laura Norman

Managing Editor
Gina Kanouse

Technical Editor
Aaron Jasinski

Project Editor
Andy Beaster

Page Layout
Gloria Schurick

Interior Designers
Steve Johnson
Marian Hartsough

Indexer
Lisa Stumpf

Proofreader
Betsy Harris

Team Coordinator
Cindy Teeters



xiii

Introduction

Welcome to Microsoft Expression Design on Demand, a 
visual quick reference book that shows you how to work 
efficiently with Expression Design. This book provides com-
plete coverage of basic to advanced Expression Design skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with the screen
illustrations in the right column, and you’re done.

How You’ll Learn

How This Book Works

Step-by-Step Instructions

Sample Files

Get Updates

Expression Studio
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
how to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond 
to the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, whereas a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Sample Files
This book uses the sample files
that are installed with Expression
Design to give you a context in
which to use each task. You can
locate these files by navigating 
on your system to the Program
Files\Microsoft Expression\Design\
Samples folder. By following
along with the sample files, you
won’t waste time looking for or
creating your own assets. Note
that not every task requires a sam-
ple file, such as “Drawing with the
Pen Tool.” In these instances, you
will perform the task from scratch.

Sample files
help you apply
what you’ve
learned to other
tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques,
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a single
concept.



Get Updates 
for Expression
Design online.

Expression
Studio
combines tools 
to create an
expanded
development
environment.

Introduction xv

Get Updates
Like any software, Expression
Design continues to change and
get better with updates and
patches, so it’s important to regu-
larly check the Microsoft Expres-
sion Design site at
www.microsoft.com/products/
expression/.

Expression Studio
Expression Design is part of the
Microsoft Expression Studio,
which also includes Expression
Web, Blend, and Media. Expres-
sion Web is a professional design
tool used to create websites that
conform to modern standards-
based sites on the web. Expres-
sion Blend is a professional
design tool used to create engag-
ing, web-connected user experi-
ences for Windows. Expression
Media is a professional asset
management tool used to visually
catalog and organize all your digi-
tal assets for effortless retrieval
and presentation.

www.microsoft.com/products/expression/
www.microsoft.com/products/expression/
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What You’ll Do

Prepare to Install Expression Design

Install Expression Design

Launch Expression Design

Identify Expression Design Interface Items

Open a Document

Open Multiple Documents at Once

View Active Files 

Create a New Document

Save a Document

Set Ruler Units

Set Ruler Origin

Change Document Size

Change the Artboard Size

View Artwork in Wireframe Mode

Introduction

Microsoft Expression Design is a powerful illustration tool
that allows you to create both vector and bitmap graphics
for use in projects created with the other applications in the
Studio suite, including Expression Web and Expression
Blend. It is only available for purchase as part of
Expression Studio and not as a standalone application. 

As a tightly integrated member of the Studio suite,
Expression Design allows you to design custom web
graphics and export them as GIFs or JPEGs for use in sites
created with Expression Web. You can also use Expression
Design to create custom user interface controls and export
them in the native XAML format for use in interfaces cre-
ated with Expression Blend. 

In this chapter, you will learn the necessary steps for
installing Expression Design on PCs running either the
Windows XP or Windows Vista operating systems.
(Expression Studio is currently not available for Mac OS X.)
You will also learn to identify the basic items of the
Expression Design interface, as well as how to open pre-
existing documents and create new ones from scratch.
Most importantly, you’ll learn all about document page
structure and how to control the size of your artboard and
document.

Once you’ve mastered these basic fundamentals, you
can move on to familiarizing yourself with the available
panels and tools in Expression Design.

Getting Started with
Expression Design
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System Requirements
Before you can install Expression Design, you
must make sure that your computer meets the
following system requirements:

Operating System:

◆ Microsoft Windows XP with Service
Pack 2 (SP2)

◆ Windows Vista

Minimum System:

◆ Intel Pentium or AMD processor, 
1 GHz with MMX or equivalent

◆ 512MB of RAM

◆ 150 MB available hard disk space

◆ 1024 x 768 monitor resolution with 
24-bit color

◆ Graphics processor that is DirectX 
9–capable

Recommended System:

◆ Intel Pentium or AMD processor, 
2 GHz with MMX or equivalent

◆ 1 GB of RAM

◆ 600 MB available hard disk space

◆ Microsoft DirectX 9.0–capable video
card with 256 MB or more of
memory—for example, ATI Radeon
X300 or NVIDIA GeForce 5600 class
equivalent or better.

If you are not sure that your computer
meets the minimum system requirements, you
can find out by referring to the Windows XP or
Vista System Information accessory. To do so,
click the Start menu button in the taskbar, go
to All Programs, Accessories, System Tools,
System Information.

Install Microsoft .NET
Framework First
If you are using Windows XP rather than Vista,
you must install .NET Framework 3.0 before
installing Expression Design. You can
download the software for free at
www.microsoft.com/downloads, or click the
.Net Framework 3.0 link available in the
Expression Studio CD set-up guide.

To install the software, double-click the
installer icon and follow the instructions in the
Setup Wizard.

Install Expression Design
Service Pack 1
After you’ve installed Expression Design, you
must update it by downloading and installing
Expression Design Service Pack 1.

Preparing to Install Expression Design

www.microsoft.com/downloads


Expression Design can only be purchased as part of the Expression
Studio suite, which includes Expression Blend, Expression Web, and
Expression Media. When you insert the Expression Studio installer
CD, a setup guide automatically displays in your default web
browser. You can use this guide to access the individual Expression
Studio product installers. Use the following steps to install
Expression Design onto your computer.

Installing
Expression Design

Install Expression Design

Insert the Microsoft Expression
Studio CD into your drive.

The installer CD displays a set-up
page in your default web browser.
Click Windows Vista or Windows
XP, depending on which operating
system you are using.

◆ If the set-up page does not
automatically appear in your
browser, choose My Computer
from the Start menu and double-
click the Microsoft Expression
Studio disc icon.

If you are using Windows XP,
install .NET Framework 3.0.

Click the Expression Design button
to access the installer and choose
Save File. Navigate to the default
download location on your system
and double-click the installer icon. 

The Microsoft Expression Design
Setup Wizard appears. Click the
Next button and follow the steps
provided.

When the installation is complete,
click Finish to exit the wizard.

5
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When you first open Expression Design, the default workspace panel
arrangement is displayed. This includes the Layers panel and
Properties panel (both docked on the right side of the screen) and
the Tools (positioned on the left). The Action bar (the gray area at
the bottom of the screen) is also open but remains blank until a doc-
ument is opened and an item is selected. By default, a new docu-
ment is not automatically opened when launching the application.

Launching
Expression Design

Start Expression Design Using
the Start Menu

Click the Start button on the
taskbar.

Point to All Programs.

Click Microsoft Expression.

Click Microsoft Expression Design.

In the window that appears, enter
your product key and click
Continue.

The Expression Design interface
appears, displaying the default
workspace panel arrangement.

5

4

3

2
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Identifying Expression Design Interface Items

Properties PanelMenu BarFlip Bar Horizontal Ruler

Vertical Ruler

Action Bar
(Remains Blank
Until a Document
Page Item Is
Selected)

Layers Panel
(Remains Blank
Until a Document
Is Open)

Artboard

Tools
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Anytime you want to create artwork in Expression Design, you must
do so within the confines of a document page. However, before you
begin creating new documents, it helps to understand how to open
pre-existing ones. Expression Design actually ships with some docu-
ments that are accessible through the Samples folder, which is
installed along with the application. To access the Samples folder,
navigate to the drive where you installed Expression Design; open
the Program Files/Microsoft Expression/Design folder.

Opening a Document

Choose the Open Command

Under the File menu, choose Open.

TIMESAVER Press Ctrl+O to
apply the Open command quickly.

In the Open File dialog box that
appears, navigate to the file you’d
like to open.

Select the filename and click
Open. The document automatically
appears in the work area of the
interface.

3

2

1

Did You Know?
You can preview the document from
within the Open File dialog box. To
preview the document before you open
it in Expression Design, check the
Show Preview check box located in
the lower left corner of the dialog box.

1

2

3



With Expression Design, you can also open multiple documents at
once. This can be useful when working with multiple web graphics
or interface items that are intended for use in much larger
Expression Web or Expression Blend projects.

Opening Multiple
Documents at Once

Select Multiple Files

Under the File menu, choose 
Open.

In the Open File dialog box that
appears, navigate to the folder
containing the files you’d like to
open.

Shift+click to select adjacent
filenames, or Ctrl+click to select
nonadjacent files. 

IMPORTANT You cannot
preview multiple selected items in
the Open File dialog box. When
opening multiple files at once,
Expression Design only allows you
to preview one document at a time.

Click Open. The documents
automatically appear stacked in
the work area of the interface.

Each document’s name is
displayed in a separate tab in the
Flip bar. Click a tab to bring the
corresponding document to the
front.

5

4

3

2

1
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When you have multiple documents open, there are several different
ways to control which one is currently being displayed. Expression
Design contains a Flip bar at the top of the document window that
displays the names of as many open documents as it can fit. By
clicking the document name, you can bring it to the front of the
stack. All open documents (including those not shown in the Flip bar)
can be accessed via the active files list located under the Window
menu, or via the Active Files menu to the far right of the Flip bar.

Viewing Active Files

Choose the Document Name
from the Window Menu

You can view a numbered list of
open documents under the
Window menu. The current
document has a check mark
displayed next to its name.

Select the name of the document
you’d like to view.

Click the Document Name 
in the Flip Bar

Each document’s name is
displayed in a separate tab in the
Flip bar. Click a tab to bring the
corresponding document to the
front of the stack.

TIMESAVER Press Ctrl+Tab to
view the next open document
displayed in the Flip bar. Press
Ctrl+Shift+Tab to view the previous
document.

1

2

1

1 2

1



Choose from the Flip Bar
Active Files Menu

The Flip bar can only display a
limited number of document tabs.
If you know a document is open
but do not see its name listed in
the Flip bar, you can access it from
the Active Files menu.

To access the menu, click the
down arrow in the upper right of
the document window, on the far
right of the Flip bar. The current
document has a check mark
displayed next to its name.

Select the name of the document
you’d like to view.

2

1
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Did You Know?
You can only display one document at
a time. Unfortunately, Expression
Design does not contain a Tile feature
that allows you to view multiple docu-
ments side-by-side.

Hovering over a document name in the
Flip bar reveals the current file loca-
tion. When you hover over any docu-
ment tab in the Flip bar, a tooltip
appears to display where the file is
currently stored on your system.

1

2
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To create graphics in Expression Design, you must first create a doc-
ument. Every document contains a frame, also referred to as the
“artboard,” which determines the visible output area for your art-
work. You can control the size of the document frame by entering
specific width and height dimensions in the New Document dialog
box. After the document is created, a black outline is displayed to
indicate the position of the artboard. All the artwork that you intend
to export or print should be placed within this area.

Creating a 
New Document

Choose the New Document
Command

Under the File menu, choose New.

TIMESAVER Press Ctrl+N to
apply the New Document
command quickly.

In the New Document dialog box
that appears, choose a preset
document size from the Presets
list, or enter specific width and
height values in the fields
provided. Choose the preferred
measurement units from the list
provided. This also determines
what units will appear in the
document rulers.

If necesssary, change the
resolution value from the default
setting (96 ppi, which is the
standard for onscreen display).
Web graphics are generally saved
at 72 ppi, and print graphics at a
minimum of 220 ppi.

It is not necessary to name the file
when setting it up in the New
Document dialog box, but the
option is there if you’d like to. You
can always name the file later
when saving it.

Click OK to create the new
document.

5

4

3

2

1

3

2

5

4

1



As you work in Expression Design, you should periodically save your
documents. Doing so allows you to preserve the work you’ve done
and return to it later, even after you’ve closed the file. There’s noth-
ing worse than losing hours of hard work due to a power surge or
unexpected system shutdown. Therefore, in addition to saving, you
might also want to consider investing in a battery backup for your
workstation.

Saving a Document

Choose the Save Command

Under the File menu, choose Save.

TIMESAVER Press Ctrl+S to
apply the Save command quickly.

The Save command is only
available when updating pre-
existing documents—not when
saving for the first time, which
requires the use of Save As.

You should also use Save As to
avoid overwriting an original
document that you’ve applied
changes to. Doing so creates a
copy of the document and allows
you to change its name and system
location.

Choose the Save As Command

Under the File menu, choose 
Save As.

TIMESAVER Press Ctrl+Shift+S
to apply the Save As command.

Enter a name for the document in
the File Name field of the Save As
dialog box. 

Choose a system location and click
Save.

3

2

1

1
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In addition to the artboard, every document also contains a set of
rulers: one horizontal (top) and one vertical (left). Expression Design
lets you decide which set of measurement units you’d like to display
in the rulers. The Units and Grids Options include points, inches, mil-
limeters, centimeters, picas, and pixels. Note that both rulers are
always visible (there is no option to hide them), and that they both
display the same measurement units.

Setting Ruler Units

Changing Document Ruler 
Unit Options

Under the Edit menu, point to
Options and choose Units and
Grids from the fly-out menu.

TIMESAVER Press Ctrl+K to
quickly access the Options dialog
box. Select Units and Grids from
the menu on the left.

In the Options dialog box that
appears, choose the preferred
measurement units from the
Document Units list.

Click OK to update the document
rulers.

3

2

1

Did You Know?
You can specify measurement unit
options when creating a new docu-
ment. The New Document dialog box
contains a Units list that allows you to
determine what measurement units will
be displayed in the document rulers.

You can easily identify what measure-
ment units are currently applied.
Expression Design displays a two-letter
abbreviation for the currently selected
unit option in the upper left corner of
the document window (where the hori-
zontal and vertical rulers meet).

1

2

3



The ruler point of origin, also referred to as the “zero point,” is the
location along the edge of the artboard where zero is positioned in
the rulers. In Expression Design, you can choose to place the zero
point for both rulers in the upper left corner of the artboard or place
it in the upper left for the horizontal ruler and in the bottom left for
the vertical ruler.

Setting Ruler Origin

Changing the Ruler Origin Option

Under the Edit menu, point to
Options and choose Units and
Grids.

TIMESAVER Press Ctrl+K to
quickly access the Options dialog
box. Select Units and Grids from
the menu on the left.

In the Options dialog box that
appears, uncheck Ruler Origin Is
Always Top Left of Artboard. This
changes the ruler origin for the
vertical ruler from the upper left to
the bottom left.

2

1
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Did You Know?
The ruler origin follows your move-
ments as you scroll. The gray area in
both rulers indicates all values below
zero. As you scroll through or zoom in
and out of the document, the gray
areas update themselves.

2

Point of Origin

Point of Origin

Point
of
Origin

Before

After

Point
of
Origin

Did You Know?
You can also create a custom zero
point. To create a custom zero point,
choose Set Document Origin from the
File menu and click and drag anywhere
in the document. When you release the
moue button, Expression Design resets
the rulers.
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Anytime you need to change the overall size and/or resolution value
of your artwork (for example, to resize a print graphic for use on the
web), you can do so by using the controls available in the Document
Size dialog box. Remember that any adjustments made using this
method affect everything in the document, including the artboard
and all your artwork.

Changing
Document Size

Use the Document Size 
Dialog Box

Under the File menu, choose
Document Size.

TIMESAVER Press Ctrl+Alt+P
to quickly access the Document
Size dialog box.

Enter new width and height values
in the fields provided. Check
Constrain Proportions to resize the
document proportionally. If
necessary, you can select a
different measurement unit from
the list provided. Doing so also
changes the units that are
displayed in the rulers after the
dialog box is closed.

If necesssary, change the
resolution value from its current
setting. Web graphics are
generally saved at 72 ppi, and print
graphics at a minimum of 220 ppi.

IMPORTANT The resolution
value does not automatically
update when adjusting document
dimensions. Therefore—because
the controls do not do the math for
you—it is difficult to interpolate
(resample) a bitmap graphic using
the Document Size dialog box.
Upsizing a low-resolution graphic
might result in unwanted pixelation
during output.

Click OK to change the document
size.

4

3

2

1

1
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If you’d like to resize the artboard without resizing your artwork, you
can do so using the controls available in the Artboard Size dialog
box. This allows you to extend your canvas and increase the output
area or reduce it to crop away portions of your art.

Changing the
Artboard Size

Use the Artboard Size 
Dialog Box

Under the File menu, choose
Artboard Size.

TIMESAVER Press Ctrl+Alt+C
to quickly access the Artboard
Size dialog box.

Enter new width and height values
in the fields provided. If necessary,
you can select a different
measurement unit from the list
provided. Doing so also changes
the units displayed in the
document rulers after the dialog
box is closed.

If you prefer, check the Relative
option and enter the exact 
amount you would like to add to 
(or subtract from) the width and
height of the artboard. Use
negative values to subtract.

Click any of the arrows in the
Anchor grid to control which sides
of the artboard will be added to or
subtracted from. To add or subtract
evenly from the center, leave the
anchor point at its default setting.

Click OK to change the artboard
size.

4

3

2

1
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By default, Expression Design displays all documents in Preview
mode, which reveals all applied attributes, such as fill colors, stroke
colors, and effects. However, if you’d like to view the paths that
make up the artwork without any attributes applied, you can do so
by switching the Display Quality setting to Wireframe mode. This is a
great way to take a look at what’s going on “under the hood” of your
artwork. Switching to Wireframe mode can also make it easier to
locate specific paths that you’d like to select and edit, especially
when working with detailed pieces of art.

Viewing Artwork in 
Wireframe Mode

Change the Display 
Quality Setting

Under the View menu, choose
Wireframe from the Display
Quality submenu.

TIMESAVER Press Ctrl+Y to
toggle between Preview and
Wireframe modes.

Expression Design displays the
paths that make up the artwork
without showing any applied fill
and stroke colors or effects.

1

Did You Know?
Natural media brushstrokes remain
visible in Wireframe mode. Natural
media brushtrokes appear just as they
do in Preview mode. The only differ-
ence is that the underlying path is
revealed.

1

Wireframe
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A
Action bar

moving objects, 73
rotating objects, 189
scaling objects, 187
skewing objects, 192
viewing controls, 18

Active Workspace, resetting, 24
Actual Size command, 34
Add Anchor Point tool, 121
adding

anchor points, 121
ruler guides, 49
text to paths, 178-182

Adobe Illustrator graphics, importing,
138

Adobe Photoshop, exporting to, 225
advanced text properties, 176
Align Center command, 80
Align commands, 80
aligning

to grids, 46
objects, 80

anchor nodes, 148
anchor points

adding, 121
converting, 123
deleting, 122

angled guides, creating, 54

area text
attaching, 181
inserting, 180

arranging objects
with layers, 98
with Order commands, 75-77

arrow keys, nudging objects, 74
artboard

dragging bitmap images onto, 170
rotating, 41

Artboard Size, changing, 15
artwork, viewing in Wireframe 

mode, 16
attaching area text, 181
Attribute Dropper, 163-164
attributes, coloring, 163-164
Auto Trace Image command, 172

B
B-spline curves, 112
B-spline tool, drawing, 124-126
Back Minus Front command, 203
basic text properties, 175
bevel joins, 141
Bézier curves, 112
Bézier nodes, 112
Bézier points, 113
bitmap images

converting to paths, 172
copying and pasting from other

applications, 168
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dragging onto the artboard, 170
importing, 167

with Paste Special command, 169
opening, 166

blend modes, applying, 157
BMP, exporting as, 226
bounding box nodes

rotating objects, 188
scaling objects, 186
skewing objects, 191

Brush Gallery, 144
brush strokes, custom brush strokes, 

145-149
brushes, selecting from Brush Gallery, 144

C
Canvas, exporting, 215
caps, changing, 141-142
Center View command, 35
changing

Artboard Size, 15
document size, 14
fill and stroke opacity, 156
layer color options, 106
Layer Render Style, 107
layer thumbnail options, 109
ruler origin, 13
ruler unit options, 12
size of grids, 45
stroke joints and caps, 141-142

circular arcs, combining with straight 
lines, 127

Clipping Path commands, 137
clipping paths, creating, 137
Clone command, 136
cloning paths, 136
closed paths, creating 

with B-spline tool, 126
with Pen tool, 117

color, applying fill color, 152
color attributes, applying, 140
Color Dropper, 163
color options, changing in layers, 106
combining straight lines with circular 

arcs, 127
commands

Align Centers command, 80
Align commands, 80
Auto Trace Image, 172
Back Minus Front, 203
Clone command, 136
Compound Path command, 133-134
Convert Object to Path command, 183
Copy commands, 85
Create Image Object, 171
Delete command, 87
Deselect command, 68
Distribute commands, 78
Divide, 205
Duplicate command, 83
Front Minus Back, 202
Import, 167
Intersect, 204
Lock command, 81
Make Warp Group, 197
Open, 166
Order commands, arranging objects, 

75-77
Paste commands, 85
Paste Special, 169
Paste with Layers command, 100
Path Operations, 201-205
Print, 214
Reflect commands, flipping objects, 193
Release Compound Path command, 135
Repeat Last Transform, 194
Reset Bounding Box, 196
Reset Transform, 195
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Reverse Path command, 151
Rotate commands, 190
Select All, 66
Select by, 67
Stack commands, 79
Unite, 201
Unlock All command, 82

committing transformations, 196
Compound Path command, 133-134
compound paths

creating, 133-134
releasing, 135

controls, viewing in Action bar, 18
Convert Anchor Point tool, 123
Convert Object to Path command, 183
converting

anchor points, 123
bitmap images to paths, 172
text to paths, 183

Copy commands, 85
copying

attributes, 163-164
bitmap images from other 

applications, 168
into different layers, 99
with layers, 100
objects, 83-85

corner points
Bézier nodes, 113
creating with B-spline tool, 125
drawing with Pen tool, 115

corners, creating rounded corners, 130
Create Image Object command, 171
crop marks

defining, 208-210
removing, 211

cusp points
Bézier nodes, 113
creating with Pen tool, 116
moving control handles, 119

custom brush strokes, 145-149

D
dashed strokes, creating, 143
Delete Anchor Point tool, 122
Delete command, 87
Delete Layer icon, 104
deleting

anchor points, 122
layers, 104-105
nodes, 120
objects, 87
path segments, 120

Deselect command, 68
deselecting, 68-69
Direct Selection tool

clicking and dragging over points, 63
editing paths, 118-120
selecting

path segments, 60
points, 61

direction of paths, 112
Distribute commands, 78
distributing objects, 78
Divide command, 205
dock, resizing, 20
docking panels, 22
document page zoom control, 29
documents

bring to the front, 8
creating new, 10
opening in Expression Design, 6-7
printing

Print command, 214
print options, 213

saving, 11
selecting items in, 18
size, changing, 14
viewing active files, 8-9

drawing
with B-spline tool, 124-126
with Ellipse tool, 131
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with Pen tool, 114-117
with Polygon tool, 132
with Polyline tool, 127
with Rectangle tool, 129-130
snapping to grids, 47

drawing guides, grids, 46
Duplicate command, 83
duplicating objects, 83-84

E
editing

paths
with Direct Selection tool, 118-120
with Pen tools, 121-123

warp group objects, 199
effects, applying live effects, 162
Ellipse tool, drawing with, 131
ellipses, creating, 131
exporting

to Adobe Photoshop, 225
as BMP, 226
as GIF, 220-221
as JPEG, 218
as PDF, 224
as PNG, 222-223
as TIFF, 219
as Windows Media Photo, 227
XAML, 215-217

Expression Design, 1
documents, opening, 6

opening multiple documents, 7
installing, 3
interface, 5
launching from Start menu, 4
preparing to install

installing Microsoft .NET Framework, 2
system requirements, 2

F
files, viewing active files, 8-9
fill color, applying, 152
fill opacity, changing, 156
Fill Transform tool, 154-155
fills

applying gradients, 158-159
image fills

applying, 153
transforming, 154-155

Fit to Canvas command, 32
Fit to Screen command, 31
Fit to Selected command, 33
flat caps, 142
Flip bar, bringing documents to the front, 8
flipping objects, 193
floating panels, 21
formatting text objects, 175-177
freeform selections, Lasso tool, 64
freehand shapes, creating with Paintbrush

tool, 150
freezing layers, 108
Front Minus Back command, 202

G
GIF, exporting as, 220-221
Gradient Transform tool, 160-161
gradients

applying to strokes and fills, 158-159
creating, 158
transforming, 160-161

graphics, importing Adobe Illustrator 
graphics, 138

grids
changing size of, 45
as drawing guides, 46
showing/hiding, 44
snapping to when drawing, 47
snapping to when moving objects, 48
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Group Select tool, selecting, 65
grouping objects, 86
guides

angled guides, creating, 54
making and releasing, 55
removing, 53
repositioning, 52
ruler guides, adding, 49
showing/hiding, 50
snapping to, 51

H
hiding

grids, 44
guides, 50
panels, 19

Properties panel, 23

I
icons, Delete Layer icon, 104
image fills, 153

transforming, 154-155
image objects, creating, 171
images, bitmap images

converting to paths, 172
copying and pasting from other 

applications, 168
dragging onto the artboard, 170
importing, 167

with Paste Special command, 169
opening, 166

Import command, 167
importing

Adobe Illustrator graphics, 138
bitmap images, 167

with Paste Special command, 169
inserting area text, 180
installing

Expression Design, 3
Microsoft .NET Framework, 2

interfaces, Expression Design, 5
Intersect command, 204

J
JPEG, exporting as, 218

K
keyboard shortcuts, 26

navigation, 30

L
Lasso tool, selecting, 64
launching Expression Design, 4
layer objects

naming, 92
renaming, 93
showing in Layers panel, 94

Layer Render Style, changing, 107
layers

arranging objects, 98
changing color options, 106
copying and pasting into different 

layers, 99
copying and pasting with, 100
creating new layers, 90-91
deleting, 104-105
freezing, 108
locking objects, 101-102
naming, 92
selecting, 96-97
thumbnail options, changing, 109
toggling visibility, 95

Layers panel
selecting layers, 96-97
showing/hiding layer objects, 94

live effects, applying, 162
Lock command, 81
locking objects, 81

with layers, 101-102
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M
Make Warp Group command, 197
marquee selections, 62
Microsoft .NET Framework, installing, 2
Microsoft Expression Design, 1

documents, opening, 6
opening multiple documents, 7

installing, 3
interface, 5
launching from Start menu, 4
preparing to install, 2

miter joins, 141
mouse wheel

scrolling with, 40
zooming, 39

moving
cusp point control handles, 119
nodes, 118
objects

with Action Bar, 73
with selection tools, 72

path segments, 118
smooth point handles, 119

moving objects, snapping to grids, 48

N
naming layers and layer objects, 92
navigation

centering view, 35
document page zoom control, 29
Fit to Canvas command, 32
Fit to Selected command, 33
fitting to screen, 31
keyboard shortcuts, 30
viewing action size, 34
working with multiple views, 36
Zoom tool, 28

New Document command, 10
New View command, 36

nodes
deleting, 120
moving, 118
selecting, 120

Nudge Increment option, 74
nudging objects with arrow keys, 74

O
objects

aligning, 80
arranging

with layers, 98
with Order commands, 75-77

copying and pasting, 85
deleting, 87
distributing, 78
duplicating, 83-84
flipping, 193
grouping, 86
locking, 81

with layers, 101-102
moving

with Action Bar, 73
with selection tools, 72

nudging with arrow keys, 74
rotating

with Action bar, 189
with Rotate commands, 190
with selection bounding box 

nodes, 188
scaling

with Action bar, 187
with selection bounding box 

nodes, 186
selecting

individual objects, 58
multiple objects, 59

selecting within groups, Group Select
tool, 65
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skewing
with Action bar, 192
with selection bounding box 

nodes, 191
stacking, 79
ungrouping, 86
unlocking, 82
warping, 197-200

opacity, fill and stroke opacity, 156
Open command, 166

Expression Design, 6-7
opening

bitmap images, 166
documents in Expression Design, 6-7

Order commands, arranging objects, 75-77

P
Paintbrush tool, 150
Pan tool, scrolling, 38
panels, 17

Active Workspace, resetting, 24
docking, 22
floating, 21
hiding, 19
Properties panel, showing/hiding, 23
showing, 19
Tools panel, 17

Paste commands, 85
Paste Special command, 169
Paste with Layers command, 100
pasting

bitmap images from other 
applications, 168

into different layers, 99
with layers, 100
objects, 85

path direction, reversing, 151
Path Operations commands, 201-205
path segments

deleting, 120
moving, 118

selecting, 120
with Direct Selection, 60

paths, 112
adding text, 178-182
B-spline curves, 112
Bézier paths, 112
clipping paths, creating, 137
cloning, 136
compound paths

creating, 133-134
releasing, 135

converting bitmap images to, 172
converting text to, 183
direction of, 112
editing

with Direct Selection tool, 118-120
with Pen tools, 121-123

freehand paths, creating with Paintbrush
tool, 150

splitting, 128
PDF, exporting as, 224
Pen tools

drawing with, 114-117
editing paths, 121-123

Pixel Preview, 212
PNG, exporting as, 222-223
points

clicking and dragging over, Direct
Selection, 63

selecting with Direct Selection, 61
snapping to, 56

Polygon tool, drawing with, 132
polygons, creating, 132
Polyline tool, drawing with, 127
positioning guides, 52
preparing to install Expression Design, 2
Print command, 214
printing documents

Print command, 214
setting print options, 213

Properties panel, showing/hiding, 23
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Q
Quick (area) Select option, 72

R
Rectangle tool, drawing with, 129-130
Reflect commands, flipping objects, 193
Release command, 55
Release Compound Path command, 135
releasing

compound paths, 135
guides, 55
text, 182

removing
crop marks, 211
guides, 53

renaming layer objects, 93
Repeat Last Transform command, 194
repeating

shapes, custom brush strokes, 149
transformations, 194

repositioning
guides, 52
stroke definition boxes, 147

Reset Bounding Box command, 196
Reset Transform command, 195
Reset View Rotation command, 41
resetting transformations, 195
resizing dock, 20
resolution, warping objects, 198
Resource Dictionary, exporting, 217
Reverse Path command, 151
reversing path direction, 151
Rotate commands, rotating objects, 190
rotating

artboard, 41
objects

with Action bar, 189
with Rotate commands, 190
with selection bounding box 

nodes, 188

round caps, 142
round joins, 141
rounded corners, creating, 130
ruler guides, adding, 49
ruler origin, 13
ruler units, 12

rotate commands, 41

S
Save As command, 11
Save command, 11
saving documents, 11
scaling objects

with Action bar, 187
with selection bounding box nodes, 186

Scissors tool, splitting paths, 128
scroll bars, scrolling, 37
scrolling

with mouse wheel, 40
with Pan tool, 38
with scroll bars, 37

Select All command, 66
Select By, 67
selecting

all objects, 66
brushes from Brush Gallery, 144
Deselect command, 68
with Direct Selection tool

path segments, 60
points, 61

with Group Select tool, 65
items in documents, 18
with Lasso tool, 64
with layers, 96-97
marquee selections, 62
nodes, 120
path segments, 120
Select By, 67
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with Selection tool
selecting individual objects, 58
selecting multiple objects, 59

tools, Tools panel, 25
Selection tool

selecting individual objects, 58
selecting multiple objects, 59

selection tools, moving objects, 72
shapes, repeating with custom brush

strokes, 149
shortcuts, keyboard shortcuts, 26

navigation, 30
Show Grid command, 44
Show Guides command, 50
showing

grids, 44
guides, 50
layer objects in Layers panel, 94
panels, 19

Properties panel, 23
Silverlight, exporting, 216
size, changing

document size, 14
grid size, 45

sizing dock, 20
skewing objects

with Action bar, 192
with selection bounding box nodes, 191

smooth points
Bézier nodes, 113
creating

with B-spline tool, 124
with Pen tool, 114

moving handles, 119
Snap to Grid, enabling, 48
Snap to Points, 43, 56
snapping

to grid
when drawing, 47
when moving objects, 48

to guides, 51
to points, 56

splitting paths, 128
square caps, 142
Stack commands, 79
Stack Gap Size option, 79
stacking objects, 79
Start menu, launching, 4
starting, 4
straight lines, combining with circular 

arcs, 127
stroke definition boxes, repositioning, 147
stroke joints, changing, 141
stroke opacity, changing, 156
stroke width, applying, 140
strokes

applying gradients, 158-159
dashed strokes, creating, 143

system requirements for Expression
Design, 2

T
text

adding to paths, 178-182
converting to paths, 183
creating, 174
releasing, 182

text objects, formatting, 175-177
Text tool, 174
thumbnail options, changing layers, 109
TIFF, exporting as, 219
toggling, layer visibility, 95
tools

Add Anchor Point tool, 121
B-spline tool, drawing, 124-126
Convert Anchor Point tool, 123
Delete Anchor Point tool, 122
Direct Selection tool

clicking and dragging over points, 63
editing paths, 118-120
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selecting path segments, 60
selecting points, 61

Ellipse tool, drawing with, 131
Fill Transform tool, 154-155
Gradient Transform tool, 160-161
Group Select tool, selecting objects 

within groups, 65
Lasso tool, freeform selections, 64
Paintbrush tool, 150
Pan tool, scrolling, 38
Pen tools

drawing with, 114-117
editing paths, 121-123

Polygon tool, drawing with, 132
Polyline tool, drawing with, 127
Rectangle tool, drawing with, 129-130
Scissors tool, splitting paths, 128
selecting from Tools panel, 25
Selection tool, 58
selection tools, moving objects, 72
Text tool, 174
Zoom tool, 28

Tools panel, 17
selecting tools, 25

tooltips, identifying shortcuts, 26
transformations

committing, 196
repeating, 194
resetting, 195
warp transformations, ungrouping, 200

transforming
gradients, 160-161
image fills, 154-155

U
unconstrained points. See cusp points
ungrouping

objects, 86
warp transformations, 200

Unite command, 201
Unlock All command, 82
unlocking objects, 82

V
viewing

active files, 8-9
artwork in Wireframe mode, 16
controls in Action bar, 18

views, working with multiple views, 36

W
warp group objects, editing, 199
warp transformations, ungrouping, 200
warping objects, 197-200
Windows Media Photo (WDP), exporting 

as, 227
Wireframe mode, viewing artwork, 16
workspaces, 17

resetting Active Workspace, 24

X
XAML (Extensible Application Markup

Language), exporting, 215-217

Z
Zoom commands, 30
Zoom on Selection command, 33
zoom percentages, changing, 29
Zoom tool, 28
zooming

document page zoom control, 29
with mouse wheel, 39
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